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o

•

Enable TLS versions 1.1/1.2 for successful HTTPS in Windows 7, Server 2008, Server
2012
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o HTTPS requirement for latest modem firmware
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Introduction
SMS Notification in TopView
TopView SMS Notification allows users to send and received text messages using a cellular modem.
Two methods are available in TopView for sending SMS messages with a cellular modem:
•

•

SERIAL: requires a cellular modem connected to the TopView machine through a Serial or USB
port. Although the connection may be USB, the cellular modem communication is through a
COM port. For USB modems the modem driver will install a virtual COM port for serial
communication. Communication between TopView and the cellular modem occurs through AT
commands over the COM port.
HTTP requires a MultiTech cellular modem that supports the MultiTech HTTP protocol. TopView
can communicate to the cellular modem over the network to send and receive text messages
using HTTP. There are no drivers to install on the TopView machine.
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MultiTech rCell 100 Series cellular modems
For HTTP SMS support we are implementing the HTTP API provided by MultiTech in their rCell 100 Series
modems.
The rCell 100 Series modems support a wide range of cellular networks (GSM/CDMA) and countries.
Please see our modem information page for the latest information regarding supported modems.
https://www.exele.com/software-products/topview/resources/cellular-modems-sms/
In the US we are using the following models:
•

•

Older models
o MTR-LAT1-B07 (AT&T/GSM, requires Mini SIM card)
o MTR-LVW2-B07 (Verizon, requires Mini SIM card)
Newer models
o MTR-LNA7 (AT&T/GSM and Verizon, requires Micro SIM card)
▪ GSM: supported in TopView 6.33 and later
▪ Verizon:
• Outgoing: supported in TopView 6.33 and later
• Incoming (alarm acknowledge):
Not supported with firmware 5.1.x
Supported with firmware 5.2.1 and later with TopView 6.34 and later
▪

SIM Inserted Status: TopView can return the status of the SIM card
(inserted/not inserted) by querying the SIM card status from the modem.
“SIM inserted” status for the LNA7 currently returns “not inserted” even if the
SIM card is inserted in TopView 6.33 because the SIM status command used for
the older models is not available for the LNA7.
TopView 6.34 can return the correct status but multiple insert/removal of the
SIM may not be correctly recognized.

You will need to obtain a SIM card (correct size) from a cellular provider for use with the cellular
modem. Please check with MultiTech for the correct rCell 100 Series modem to support your cellular
carrier.

7

Configuration Overview
Note: this document will refer to the MultiTech rCell 100 Series modem as “cellular modem”
1.
2.
3.
4.
5.

Configure the cellular modem for your network
Use a browser to connect to cellular modem web configuration tool
Make changes to the cellular modem settings to communicate with your network
Make changes to the cellular modem settings to enable the HTTP API
Test sending and receiving text messages

Insert SIM card into the cellular modem
With the modem power off, insert your SIM card into the cellular modem’s slot labeled SIM. Power on
the modem.

Warning: removing the SIM
If you remove and re-insert the SIM while the modem power is on, you should restart the modem.
Failure to restart the modem after a new SIM insertion may prevent the modem from successfully
sending and receiving SMS messages.

Warning: changing the SIM in LNA7 modem
If you change the SIM card with the same cellular provider (Verizon), or if you change providers, you
may need to reconfigure the modem before the new SIM will work.
More information on this issue is available from MultiTech’s firmware 5.2.2 release notes
The primary steps to resolve a cellular connection issue when changing the SIM:
•
•

ADMINISTRATION > DEBUG OPTIONS
Click [Reset Class 3 APN (Verizon)
CELLULAR > CELLULAR CONFIGURATION
Click [Reset to Default]
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Configuring the cellular modem for your LAN network
The cellular modem has an Ethernet port labeled E-NET and a default IP address of 192.168.2.1
By default the cellular modem should operate as a DHCP Server upon first boot. We’ve seen various
behaviors depending on the model. For initial web configuration you can connect an Ethernet cable
between a computer and the cellular modem. If the computer is set automatically obtain its IP address
(DHCP) you should be able to see the cellular modem through a browser at its default IP address
192.168.2.1 (https://192.168.2.1)
If you cannot connect to the modem after a few minutes, configure your ethernet adapter with a static
IP address that can access 192.168.2.1. For example, you can set your ethernet IP address to
192.168.2.10
•
•

From the command prompt type: ping 192.168.2.1
(newer firmware may not allow ping – try to connect using your web browser)
Open a web browser and go to http://192.168.2.1 or https://192.168.2.1
* If you receive a security notice, ignore and continue
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Web Configuration
Log into the device
Open your web browser and enter the address
http://192.168.2.1 or https://192.168.2.1
Firmware version 4.0 and above:
•

Choose a username and password

Firmware Version 3.7 and below:
•
•

Username: admin
Password: admin

Making changes: restart required?
When you apply changes to the modem using the web configuration tool, some changes will require
that you restart the modem while others are applied without a restart prompt.
If you have configured modem settings yet are still having problems with the modem, we recommend
that you restart the modem to ensure that the most recent changes are loaded.
To restart the modem from the web configuration tool:
COMMANDS > RESTART DEVICE
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First-Time Setup Wizard
A setup wizard will appear the first time you access the web configuration. Enter the following
responses to each question.
Note: some setup wizard screens may not appear or may appear differently based on the version of the
modem’s firmware.
•
•
•
•

•

•
•
•
•

•

Mode: Network Router
Choose password: enter the current password (admin) and a new password if you would like to
override the default password.
Time configuration: Set your current time zone first, then the date and time if they are not
correct.
Network interface: leave bridge as br0.
IPv4 address: most users will want to assign an IP address for their current network. Set the IPv4
address and Mask as required.
If DNS is also visible on this screen (older firmware), you should set the DNS to the IP address of
your DNS Server.
Cellular Configuration/Cellular PPP Configuration: this setting allows the modem to use the
“data” portion of your cellular plan. This setting should not be required for SMS but may be
required if you want the modem to sync its time to a time server.
For our testing we uncheck “Enabled”. We recommend starting with this option
disabled/unchecked. See “Modem Time Sync Options” for more information.
Note: some users have reported that they reduced SMS send failures by enabling PPP. Our
testing shows success with or without this setting enabled, but if you experience send failures
you may want to enable this setting (Web UI>Cellular>Cellular Configuration) or enabled it now.
Cellular Authentication/PPP Authentication: most users will select NONE
Remote Management: do not check “Enabled”
Admin : most users will disable
Access Configuration: this screen will appear in newer firmware versions.
For “HTTP Redirect to HTTPS” check :Enabled”, “check: via LAN”
Newer firmware (v5 and later) requires use of HTTPS so we recommend that all users configure
the modem for HTTPS only to reduce issues with future firmware upgrades
Bootloader Protection: this screen will appear in newer firmware versions.
Authentication Status should be disabled. Most users should not enter a password for the
bootloader.
Click [Finish]

DO NOT RESTART THE DEVICE YET.
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Remove DHCP setting
Most users have an existing DHCP Server on their network and will not want to use the DHCP Server in
the cellular modem if it is enabled. Depending on your firmware version, the cellular modem may be
configured to act as a DHCP Server. With newer firmware DHCP will already be disabled.
SETUP > DHCP Configuration
Newer firmware should show “Disabled” for the status of the interface of your local IP address (IPV4).
If DHCP is enabled (IPV4), edit the DHCP setting using the pencil icon if it is visible.
•
•

Uncheck “Enabled”
Click [Submit]

If DHCPv6 and Router Advertisement is enabled you should be able to leave this enabled.

SIM Pin
If your SIM card requires a pin number
CELLULAR > Cellular Configuration
Under Modem Configuration enter the SIM Pin.

Restart the device
SAVE AND RESTART > then click [OK] to restart the cellular modem

Move Ethernet cable from computer to network switch
You can now unplug the Ethernet cable from your computer and attach it to your network (e.g. a
switch). Once the cellular modem is connected to your network and has restarted you can log back into
the web configuration using
http://ipaddress or https://ipaddress
where ipaddress is the new IP address assigned in the setup wizard. Remember to use the new admin
password that you assigned in setup wizard.

Upgrade firmware to version 5.3.0
In order to ensure compatibly between TopView and the modem, we recommend upgrading to the
version stated in this document. This is the latest firmware version that we have tested.
If your modem firmware is later than this version you can skip this step. If you encounter any issues with
a newer firmware version please contact Exele support.
ADMINISTRATION > FIRWARE UPGRADE
To download newer firmware
•
•

Click on your cellular modem model on the MultiTech rCell 100 Series page
Click DOWNLOADS
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Modem Time Sync Options
It is important for the modem to have the correct time, especially when looking at the modem logs for
SMS messages sent by TopView.
You have two options for ensuring that the modem has the correct time.
1. Allow the TopView machine to set the time of the modem
2. Allow the modem to sync its time with a time server (requires local gateway/DNS or Cellular
Configuration enabled)
Once you select an option, the other option should be disabled.

Allow the modem to sync to a time server
The modem can automatically update its time if it can reach the configured SNTP time server. The
default time server is a hosted time server that will require Internet access. If the time server is not
local, you will need to configure a gateway and DNS for the local network connection OR enable cellular
data.
Enable time sync
SETUP > TIME CONFIGURATION
SNTP: check “Enabled”
Set the polling time to 5 minutes
Allow the modem to reach the time server – local network
Firmware 5.2.1 and later
If the local network has access the Internet and you are using an Internet time server, the modem
should be able to reach the time server if you configure the gateway and DNS for the local network
connection.
STEUP > NETWORK INTERFACES
Edit network interface br0 (click pencil)
Enter your Gateway and Primary DNS Server
Click Submit, the Save and Apply
Recommended: restart the modem if not prompted to restart
Allow the modem to reach the time server – cellular network
This option required a data plan on your cellular service/SIM
CELLULAR > CELLULAR CONFIGURATION
Check “Enabled”
Click Submit, the Save and Apply
Recommended: restart the modem if not prompted to restart
Check the status of the modem time sync (SNTP)
STATUS & LOGS > SERVICES
Verify that the SNTP service status is successful. If SNTP continues to fail you should disable SNTP (SETUP
> TIME CONFIGURATION) and allow TopView to set the time of the modem.
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Allow TopView to set the time of the modem
In TopView 6.34 and later, TopView can set the time of the modem when it sends SMS messages and
polls for incoming messages.
This option requires that SSH is enabled on the modem. To check this setting, go to
ADMINISTRATION > ACCESS CONFIGURATION (Set to enabled, port 22, via LAN).
Enable this option in TopView:
Launch the TopView Configurator, select Global Options>Notification.
Email-SMS section: check “Sync cellular modem’s date and time with this machine”
Test the ability of TopView to sync the time of the modem (v6.34 and later)
Note: you will not be able to perform this step until you have completed configuration of the
modem and successful connection/send SMS from TopView. If you have chosen this option for time
sync make a note to return here after you have completed the modem configuration and
connection from TopView.
•
•
•
•
•

Launch the TopView Configurator and open your configuration file
Left menu: Email-SMS Notification > [Configure]
Outgoing SMS Setting screen
Click [Test modem] to verify connection to the modem. The current time of the modem is
displayed.
Click [Sync time]
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Verify a few items…
Cellular signal
•

HOME >
The Device Information screen gives an overview of the cellular modem state.
Verify that you have a cellular signal:

There are a few default settings that must be correct before you can enable SMS. Please verify the
following settings are correct:
Cellular > Wake Up On Call
•

Verify that “Wake up on call” is not checked
Enabling SMS (below) will not be possible with this option checked

DNS:
Ensure you have the proper DNS address set for your LAN.
You should have one of the following options depending on your firmware:
SETUP > IP CONFIGURATION > DNS
or
SETUP > GLOBAL DNS
•
•
•

Enable Forwarding Server
Primary Server: enter the IP address of your DNS
Submit

SETUP > TIME CONFIGURATION
•
•
•

Current: verify that the current date/time/zone are set correctly
SNTP: enabled or disabled based on your selected option in “Modem Time Sync Options”
Submit
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Enable SMS
SMS > SMS Configuration
•
•
•

•

Check “Enabled”
Send and Receive SMS to Keep: 1000
Resend Failed SMS: 5
* When TopView sends an SMS message to the cellular modem it is placed into a queue on the
cellular modem. TopView does not wait for the message to complete sending.
Enter a value for “Resend Failed” if you would like the cellular modem to retry failures.
Click [Submit] to save these settings

Verify connection to your cellular carrier
CELLULAR > RADIO STATUS
The radio status will display connection information for the connected cellular service.
Expected information:
•
•
•
•

Home Network: Cellular service provider
RSSI: Received Signal Strength Indication
Service: Cellular service connection type
MDN (Phone Number): Mobile Directory Number. In some SIM/carriers, the value may not be
present and therefore not displayed

If you are not connected to the cellular service, you can try to reset the cellular connection
ADMINISTRATION > DEBUG > RESET
SAVE AND RESTART > then click [OK] to restart the cellular modem

Send a test SMS message
SMS > Send SMS
•
•
•

Enter a recipient phone number and click [Add]
Enter a Message
Click [Send]

SMS > Sent
You should see your test message listed. After a successful send the Status should change to
“sent”. You may need to refresh your browser to see the changed status value.
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HTTP or HTTPS?
TopView communicates to the modem using HTTP/HTTPS commands.
We recommend using HTTPS. Newer versions of the modem firmware (5.0 and later) have removed the
“enable HTTP” settings available in earlier versions of the firmware. If you are using an earlier version of
the firmware that allows HTTP, upgrading to later versions may persist “enable HTTP” while also
removing your ability to change this setting. Therefore, we recommend all users configure the modem
for HTTPS access only.

TLS Version and Cypher Suites
TLS is the encryption protocol used by the modem for HTTPS and therefore by TopView.
Newer versions of the firmware (5.3.0 and later) support TLS v1.3 in addition to v1.2 and v1.1.
TLS v1.3 is not supported by TopView so you need to verify that TLS v1.2 is enabled and that supported
cypher suites are enabled.
ADMINISTRATION > ACCESS CONFIGURATION
•
•
•

•

To the right of “HTTPS Security” click “Show” to open up the HTTPS Security information
TLS Settings: verify that TLSv1.2 is enabled
Encryption (Cypher Suite Name)
Under the TLS version checkboxes are a list of security cypher suites supported by the modem.
o Older modems included all cyphers by default (all items checked)
o Newer modems may not include all cypher suites (the deprecated items may be
unchecked). Older Windows operating systems that do not support modern cypher
suites may fail to connect if these deprecated items are not checked. See “Error!
Reference source not found.”
o To prevent connection issues, we recommend checking all cypher suites in this list. After
successful connection from TopView you can return and to see if unchecking the
deprecated cypher suites affects your connection.
Scroll to the bottom of the screen and click [Submit]

HTTP
Note: we recommend using HTTPS instead of HTTP. Some of the HTTP settings in this section are only
available in earlier versions of the firmware and are removed in later firmware versions.
If you are using a version of the firmware that supports HTTP (before v5) and still desire to use HTTP
instead of HTTPS:
ADMINISTRATION > ACCESS CONFIGURATION
•
•
•

Check “HTTP…Enabled if not already checked (not available in v5 firmware)
Uncheck “HTTP…Redirect to HTTPS
Click [Submit] to save changes

SAVE AND RESTART > then click [OK] to restart the cellular modem
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HTTPS
Use of HTTPS requires the creation of a certificate on the cellular modem and installation of the
certificate on the TopView machine.
IP Address or DNS/host name for the certificate?
The certificate will be created for the modem’s IP address or DNS name.
Most users will access the modem by it’s assigned static IP address and will create the certificate for the
modem using the IP address. If you or your IT group created a DNS name for the modem’s IP address
and are required to use this name, you should create the certificate using the DNS name and not the IP
address. This is specified in the “Common name” field below.
*If you create the certificate for the DNS name you must use this name, and not the IP address, when
configuring access to the modem from TopView.
Log on to web configuration using HTTPS
Log on to the cellular modem web configuration using HTTPS
https://ipaddress
where ipaddress in the IP address of the cellular modem
Create the certificate
ADMINISTRATION > CERTIFICATE MANAGEMENT
or
ADMINISTRATION > X.509 CERTIFICATE
•

Click [Create] or [Generate]
o Common Name: ipaddress or DNS name of the cellular modem.
Most users will enter the IP address in this field. See “IP Address or DNS/host name for
the certificate?” above for more information.
o Days: 9125

The certificate will expire after the entered number of days. The value days=9125 will set the
expiration for 25 years from today. TopView may be unable to use the modem after the entered
number of days.
o
o
o
o
o
o

Country: US (or see here for a list of country codes)
State/Province: your State or Province
Locality/City: your City
Organization: your company name
Email address: the email address for this certificate
Click [Generate] to create the certificate in the cellular modem

SAVE AND RESTART > then click [OK] to restart the cellular modem
POWER OFF then ON
In some cases the new certificate is not loaded during the restart of the device. Therefore we
recommend that you power off the device, then power it back on by removing/inserting the power
cable for the modem.
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Install the certificate
You must now install this certificate on the TopView machine:
Using one of the browsers listed below, navigate to the cellular modem web configuration and follow
these instructions to copy the certificate to a file on the TopView computer:
•

Chrome and newer Edge:
o press F12 to bring up developer tools and select
Security tab > View Certificate > Details > Copy to file

•

Internet Explorer:
o Select the lock icon in the address bar
Details > Copy to file >

•

Firefox:
o

•

Select the lock icon in the address bar > Select the arrow on the right
More Information > View Details > Details > Export

Internet Explorer (IE)
o Run IE as Administrator (required to save certification to file). Select the lock icon to the
right of the address bar > View certificates > Details > [Copy to file]

Copy the certificate file to the TopView Computer.
On the TopView computer:
•
•
•

•

Start > Run > MMC
*Run MMC as Administrator
File > Add/Remove Snap-in
Select “Certificates”, then [Add>] button
o Choose “Computer account”
o Choose “Local computer”
Be sure to select Local computer which may not be the default
o Click [Finish]
o Click [OK]
Certificates > right-click Trusted Root Certification Authorities > All tasks > Import
o [Next]
o Browse to certificate file
o [Next]
o Place in the following store: Trusted Root Certification Authorities
o [Finish]
o In “Trusted Root Certification Authorities” verify that the listed expiration date is 25
years in the future

Additional steps: Windows 7, 2008, 2012 users
See “HTTPS and TLS Errors” for more information
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Restart and verify
We want to verify that you entered and stored the correct settings. Sometimes you may enter a setting
but forget to click [Submit].
SAVE AND RESTART > then click [OK] to restart the cellular modem
Browse the previously changes settings and make sure that they are set correctly.

Send test SMS from TopView
•
•
•
•

Start the TopView Configurator
Open an existing configuration or start a new configuration
From the left menu select “Email-SMS Notification” then click [Configure]
Select “Outgoing SMS Settings” tab
o Select “MultiTech rCell modem” or “Use modem via HTTP”
o Host:
▪ Http or Https: based on how you configured the cellular modem in previous
steps. We recommend HTTPS
▪ Ipaddress: the configured IP address or DNS name of the cellular modem
o Username: the username for the cellular modem
o Password: the password for the cellular modem
o Test the connection
▪ Click [Test modem]
▪ If successful you should see modem information displayed
o Send a test SMS message
▪ Message: leave the default message or change to the desired test message
▪ Phone #: enter the recipient SMS number
▪ Click [Send test SMS message]

Failure: If you connection fails with an SSL/TLS error, see “HTTPS and TLS Errors” for resolution steps.
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Verify that modem can receive SMS messages
If you will use the cellular modem to receive SMS messages (alarm acknowledge and information
request) you should verify that the cellular modem can receive SMS messages.
•
•

•
•

Log into the cellular modem at http://ipaddress or https://ipaddress where ipaddress is the IP
address of the modem
Note phone number of the modem:
o CELLUAR > RADIO STATUS
o The phone number is displayed: “MDN (Phone number)”
Send a text message from a cellular phone to the phone number of the modem
Check the inbox of the modem
o SMS > RECEIVED
o Check “Auto Refresh” to see new messages as they appear

Diagnosing incoming SMS issues - Verizon
Model MTR-LVW2 (older model)
With firmware 5.1.x and earlier, this modem requires a SIM that allows storage of SMS messages on the
SIM card. See our TopView SMS modem information page for required SIM SKUs and how you can
obtain a compatible SIM.
With firmware 5.2 and later you should not need to use specific SIM cards with this modem.

Model MTR-LNA7 (newer model)
With firmware 5.1.x and earlier, this modem cannot receive incoming messages.
With firmware 5.2.1 and later you should be able to receive incoming SMS messages if you are using
TopView 6.34 or later.
Set SMS Format to “Verizon”
To receive incoming messages, you need to ensure that the modem’s LTE SMS Format is set to
“Verizon”. From the TopView Configurator, Email-SMS Settings, Outgoing SMS Settings:
•
•

Click [Test modem]
If the displayed LTE SMS Format is not “Verizon”
o Click “Check and enable SMS format (MTR-LNA7)”
o Set the SMS format to “Verizon” and click “Apply”. Read the setting to verify.

Return to the modem’s web configuration and check SMS > RECEVIED. If this resolved the issue, you
need to set the global option as explained in the next section.
Set Global Option to verify SMS Format = Verizon
If you changed the SMS format to “Verizon” to resolve the issue, this format will only persist until the
modem is restarted. Therefore, you need to instruct the TopView Engine to check and reset the format.
From the TopView Configurator:
Global Options > Notification > Set SMS format of modem to [Verizon]
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Create separate user accounts
Note: Firmware version 4.0.5 and later only
We recommend creating a separate user account on the modem for each TopView Engine/configuration
that sends/receives SMS messages through the modem.
•
•
•
•
•

Log into the cellular modem at http://ipaddress or https://ipaddress where ipaddress is the IP
address of the modem
On the side panel select [Administration] -> [User Accounts]
Click [Add New User]
Choose a username and in the [Role] dropdown select administrator. The other fields are
optional
Click [Submit] then choose a password
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HTTPS and TLS Errors
Connection issues related to TLS may occur on older Windows versions (Win7, Server 2008/2012) due to
their supported TLS version and supported encryption levels. You may also experience errors on newer
Windows versions if the default TLS settings have been changed. Errors can also occur if the modem’s
certificate is not installed on the TopView machine or if the certificate is not valid.

SSL/TLS Errors
The following errors can occur in the TopView Configurator while testing the connection to the modem:
•

•

The underlying connect was closed.
Could not establish trust relationship for the SSL/TLS secure channel
o Typical cause: certificate issue or Windows machine TLS version or cypher not supported
The request was aborted.
Could not create SSL/TLS secure channel
o Typical cause: Windows machine TLS version or cypher not supported

Resolution steps
Confirm modem TLS and Cypher settings
The modem configuration includes ensuring that the correct TLS version and cypher suites are enabled
in the modem. See “TLS Version and Cypher Suites” and verify these settings in the modem. Reboot the
modem if changes are made.

Verify/Set TopView machine TLS and Cypher versions
Most users should be able to use IIS Crypto to set the correct TLS versions. For older operating systems
you can also follow the steps in the Microsoft article “Update to enable TLS 1.1 and TLS 1.2”.
IIS Crypto
IIS Crypto can set the TopView machine’s client protocols to support the TLS version required by the
modem.
•
•

•

•

Download and run IIS Crypto GUI
Backup your current registry settings
o Select Advanced from the left menu
o Click [Backup registry]
Select Schannel from the left menu
o Click [Best Practices] button
o Click [Apply] button
o Reboot the computer
Test TopView’s connection to the modem
o If the connection to the modem is still failing and you are using an older version of
Windows, follow the steps in the next section “Microsoft article “Update to enable TLS
1.1 and TLS 1.2””
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Microsoft article “Update to enable TLS 1.1 and TLS 1.2”
The required steps are detailed the Microsoft Support article “Update to enable TLS 1.1 and TLS 1.2 as
default secure protocols in WinHTTP in Windows” and summarized here:
1. Apply KB3140245
Download and install the KB3140245 update for your operating system
2. Add DefaultSecureProtocols registry keys.
This can be done manually or by downloading and running the “Easy Fix” referenced in the
article. We recommend that you run the Easy Fix.
3. REBOOT
4. Additional steps
If the error still exists after rebooting you should perform the additional steps listed in the
article for Windows 7 even if you are running Server 2008 and Server 2012.
Additional steps: create the necessary registry subkeys for TLS 1.1 and 1.2.
Create the DisabledByDefault DWORD values and set it to 0 in the following locations.
Warning: Be sure to enter these items exactly as listed - note the space between “TLS” and “1.1”
or “1.2”. You can also create a .reg file using the examples below to add these items to the
registry.
a. For TLS 1.1
Registry location:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANN
EL\Protocols\TLS 1.1\Client
DWORD name: DisabledByDefault
DWORD value: 0
Example .reg file
Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\
Protocols\TLS 1.1]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\
Protocols\TLS 1.1\Client]
"DisabledByDefault"=dword:00000000

For TLS 1.2
Registry location:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANN
EL\Protocols\TLS 1.2\Client
DWORD name: DisabledByDefault
DWORD value: 0
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Example .reg file
Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\
Protocols\TLS 1.2]
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\
Protocols\TLS 1.2\Client]
"DisabledByDefault"=dword:00000000

5. Reboot

Bypass Certificate Errors
TopView version 6.36 and later allow the user to temporarily bypass certificate validation to help
diagnose connection errors due to certificates.
•
•

TopView 6.36: Download the 6.36.1.5 update from the TopView 6.36 download page
TopView 6.37 and later: enable certificate bypass in Global Options > Notification

Warning: enabling this setting may bypass certificate validation for other servers used by TopView.
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Restrictions and Notes
•
•
•

This modem and API will only send messages of 160 characters or less. TopView will break up
longer messages into multiple smaller messages.
Messages sent via this modem only support ASCII text. Unicode characters will not display
correctly.
Only user accounts with the Administrator role can send SMS messages
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